Subject: What is Autorun?



What is Autorun?

Autorun is a function within Calypso, which allows
a pre-programmed part to be run by unskilled
Calypso operators.

It provides an interface, which can be customized
to have no resemblance to Calypso.

The functional aspects of the program can go from
the basic level where simple parts are measured
in batches, to the more advanced level where
programs are selected from a pre-defined list and
flow structure.

Let is have a look at the basic elements and
explain why they are used and how they are
created.

The basic Autorun interface.

m and Location Plan CAD Extras Planner Window Help Inb

L é ﬂ E | B cncstan

Mavigation... i

s W

Mini-Plan "
User Information [
fdvanced [

¢

AutoRun... h ;

Travel to nominal posifion...

Preassign CNC Start Values ’
3
*

B

._“‘4,%hn,‘¢k-r«.._ ) pen i, WI—M el

Autorun cannot be run if any programs are open in
Calypso, before trying to access it, close all open
programs.



Go to the Plan menu option, and select the
“Autorun” option
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As you can see the graphical interface that is
introduced has no apparent connection to
Calypso, the interface is different and the
appearance can also be changed to make no
reference to Zeiss.

Lets take a little tour around the environment and
see what some of the options are.
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As you can see the menu options and icons which
are available on the toolbar are different from
those, which are displayed in Calypso.

The File menu offers

" the file related options,
[ New Nok that are available in
Autorun.
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The Configuration settings give you access to
various areas where changes need to made.
The “CMM”. “Measurement” and “Environment”
options place you into the Calypso configuration
settings for the CMM, Measurement and
Environment.

The User settings allow you access to creating
new users and assigning their privileges.
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The Edit menu option allows you to modify
settings within the Autorun environment.
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The “Desk” is the screen or interface that you are
viewing in Autorun, these options allow you to
define new visual screens.
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The Stylus System options give you access to the
stylus related functions for changing and
qualification of the styli.
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The Tools that are made available to you are
various functions that help you under certain
circumstances.




As can be seen from the options which are
available, control is supplied to the user to use and
modify run parameters. Le us now look at a series

of applications which will utilize the various options
available to us.

Case Study 1
Requirement.

We manufacture a very simple part, a cup, and we
wish to constantly monitor its quality. What is
available within Autorun to help me?

Solution.

The first step is to create a Calypso program that
is going to be used within Autorun, in this instance
it would be a full inspection on all of the supplied
parts.

Question 1

How are we going to mount the part?
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Our solution is to mount the part in a simple fixture
such as the one shown above. However, this only
handles one part, we want to handle several.

Our new fixture positions the cups in the required
orientation but now does it with 24 cups a much
quicker method of measuring.



Question 2
How do we tell Autorun what we have done?

The first step is to create an alignment of the
fixture relative to the machine volume, this tells
Calypso the orientation of the fixture carrying the
parts.
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This is called the Pallet alignment

The second step is to define the base alignment
for the parts that sit inside the pallet.

This is the alignment that was assigned to the
inspection plan for the part, which we had
previously created.
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As can be seen from the dialog box shown above,
we enter the values in the Pallet parameters that
tell Calypso what the misalignment of the plate to
the machine is and the maximum number of parts
that could be in the plate.
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When the program is run at these settings, the
program will measure each cup at the 24
locations.
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However if we only select certain areas to
measure, Calypso will be able to skip over the
unmarked positions because it knows the
necessary parameters to miss these locations.

Case Study 2
Requirement

We have a full program that has been separated
into mini plans and we need to set it up so that our
operators can go on the machine and select the
correct program without knowing where the
programs are stored.

Solution

Our program has been created which contains 3
mini plans called, Front Face, Top Face and Side
Face.

These are the names we will use in our example,
but the popular way of structuring this is OP10,
OP20 and OP30 detailing different levels of the
manufacture of the part.
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Within Autorun, we will use different parameters to
choose our programs, we will use an icon. Select
the icon that is shown above.
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When requested, point it to the program that
contains the mini plans.
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Highlight the logo and click on the Edit menu
option. Select Measurement Plan and then Define
Run Parameters.
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Click on the Mini Plan that you wish to assign to
this icon.
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Repeat this for the other operations until you have
three icons available.
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To run a particular file select is from the list and
click on “Run”.

Case Study 3
Requirement

| produce parts for a series of competing
companies and | need a way to be able to make
sure that my operator picks the correct program
but do not wish to give him complete access to my
files.

Solution
This is a little more difficult to explain, but it
involves the creation of a series of levels. A level

is @ new screen that can be called in navigation.
In our example we will need:
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. An opening
. A screen to select the company
. A screen to select the engine (for

screen

each company)

each company)

. A screen that actually defines the

. A screen to select the part type (for

programs to be run for the selected
part (for each company).

Select
Company

Company A

Company B

Engine 1

Engine 2

Engine 3

Engine 4

Our basic structure will look something like this,
obviously in your case the divisions and
separations would be different, but this is the
general flow.
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Each new screen that is displayed is called a
“Desk”.

| found it less complicated if | initially created a
paper creation of a layer with its name on it. This
allowed me to lay out the paper on the floor in the
order | needed them. Any missing layers were
visually obvious. From my paper approach, | can
define how many Desks | needed . You may wish
to call them Desk numbers first and worry about
actual names later when the navigation is sorted.
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After you have created the new desks and wish to
see how many you ended up with, click on the
down arrow in the Desk drop down and it will show
you all of the created desks.
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The second part of the procedure is to create a
link between the Desks, this is our other
navigational tool and is works in a similar way.

A link is a button which, when selected, will direct
us to where its destination is.

Opening desk
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To add a link make sure that the first page is open
By selecting it from the list.
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To insert a link from Desk 1 to Desk 2 we need a
link or “Desk Link™ on our main page. Click on the
link and it will insert the raw link onto our page.
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Select Desk
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Select the name of the destination Desk and the
link will be entered into the program.
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If you double click on this link, it should take you to
the page or desk that you assigned.
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We can see that double clicking took us to this
Desk, which is where we wanted to go.

Return to Desk one and add another Desk link but
this time point it to Desk 2b.

Calypso has a habit of placing new links in the
upper left corner of the screen, which means that
a second link will actually cover the first.
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Click on the links to highlight them and drag them
into the desired visual location on the screen.
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Don’t forget that you can test your navigation by
double clicking on the icon and checking where it

goes.

This is where the initial naming of the desks and
the paper navigation aids will help you, complete
the navigation to meet your requirements, until you
reach the last page.

The last Desk is a little different, this desk will
actually select the measurement plans that need
to run from the icons on the page.
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On the final page, click on the icon shown and
select the program from the list that you wish to
run when this icon is selected.
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You can see that the icon pointing to the
measurement plan has been added, but it needs
the run parameters to be set for the program itself.
Click on the icon to make it active, and then right
click and select Define Run Parameters.
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What has to be assigned here is
* The alignment that the program is
relative to.

* The mini plan that is to be run if one
exists for this program.

The alignment really depends on the way that you

wish to run your program, but typically this would
be the name of the program,

The mini plan approach is where you have taken
the time to subdivide your programs into mini-

plans. In our example there were three mini plans

that were available for this program.
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] Compact g
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{+» All Characteristics [] Send results
"+ Current Selection ;
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FrontEace 1 | Hesults to file é
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Top Face :
&
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In this instance, we would have four separate
icons in on this desk. One would run the whole
program and the other three would run the
respective mini plan.
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One last element to discuss regarding this plan is
the inclusion of graphics that can be included in
the Desks.

Each icon can have a graphic assigned to it, just
right click to access the graphical options.
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If you wish to add a graphic to the background,

with nothing selected on Desk, right mouse click to

access the graphic options,

Add Measurement Plan...
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Add Desk Link...
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In conclusion, lets have a look at the screens that
were produced to create our navigation.
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5 Kutomatic Run
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The final page has background graphics to both
the screen and to the individual links.

The Autorun class is a 1 day class
typically taught at one f our training
facilites:

For more information contact regarding
the availability of a class, contact:
Mcordova@zeiss.com

Or call her at 1-800-327-9735 — option 4
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